
Microsoft Office 2007 Tips 

These tips have been accumulated over the years for the SISD Announcements.  
They are in no particular order. 

Add Print Preview to Word 2007 Toolbar 
Click the down arrow on the Quick Access toolbar to the right of the MS Office button. On the dropdown 
menu, select Print Preview to put a check by it, and it will be added to your Quick Access toolbar. 
 
Insert Shapes in Word 2007 
When you click the Insert menu in Word 2007, you’ll be presented with the Insert Ribbon. This displays 
commands for inserting different elements into your Word document. It is divided into seven sections, 
grouped by command. The Shapes section presents you with options for inserting different autoshapes and 
drawing objects into your document. Just click a shape, and then click and drag on your document to 
insert it. You will then see the Format Ribbon with all of the formatting options for your shape. 
 
Create WordArt in Word 2007 
Type the text with which you would like to create a WordArt graphic. Select the text, and then open the 
Insert Ribbon. Click on the WordArt button in the Text section. Choose one of the pre-formatted text 
choices. Change the font and size if necessary. Click OK. You will then see the Format Ribbon with all of 
the formatting choices available for changing your graphic. 
 
Insert a Picture in PowerPoint 2007 
On the Home Ribbon, click on the New Slide button in the Slides section. Choose the slide that best suits 
your idea. Try Picture with Caption. Click the icon to add a picture from your computer. Find the picture 
you wish to use, click on it, and then click Insert at the bottom of the Insert Picture window. You will then 
see the Format Ribbon with all of the formatting choices for your picture. A neat new feature is Picture 
Styles. To finish the slide, add a Title and Caption beneath it. 
 
Add a Symbol in Word 2007 
To add a symbol to your document, click on the Insert Ribbon. Choose Symbol from the Symbols section 
at the end of the ribbon. Click More Symbols to bring up the Symbol window. You can find more symbols 
by changing the Font. The Wingdings font is a picture font. To insert Special Characters, click on that tab 
to see the Shortcut Keys to use. 
Create Text That Glows in PowerPoint 2007 
1. Select the text that you want to glow. 
2. Click the Format tab on the Menu Ribbon. 
3. In the WordArt Styles section, click Text Effects, and choose Glow. 
4. Choose your desired glow variation (color and size of glow). Or, click on More Glow Colors to choose 
from more colors. 
 
Switch Between Portrait and Landscape Modes in Word 2007 
1. Click on the Page Layout tab on the Menu Ribbon at the top of Word 2007. 
2. In the Page Setup section, click the Orientation command.  
3. Choose your desired page orientation from the pop-up that appears.  
 
The Word 2007 Window 
The Word 2007 window differs substantially from earlier versions of Word. For those new to Word, it is 
more intuitive. Many of the commands and options have been moved out onto what Microsoft dubs the 
“ribbon.” But for experienced users of Word, it is a new way of looking at Word. Much of what you know 
you’ll need to relearn. 
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The Microsoft Office Button 
The Microsoft Office button is in the top-left corner of Word 2007. It provides fast access to files and 
frequently used commands. Here you can open or save a file, publish a file to a blog, save a file in PDF, 
email a file, or print a file. This is also where you’ll find a link to the Word options.  
 
Word 2007's Quick Access Toolbar 
The Quick Access toolbar is remarkably simple. You can use it in Word 2007 to save or print a file. You 
can also use the buttons to undo or redo commands.  
 
Word 2007's Menus 
The Word 2007 menus are remarkably different from earlier versions of Word. Only a couple of the menu 
names will be familiar to experienced Word users. When you’re familiarizing yourself with Word 2007, 
this is the place to start. The menus include Home, Insert, Page Layout, References, Mailings, Review, 
and View. 
 
Home Ribbon in Word 2007 
When you click on a menu in Word 2007, you won’t get the traditional drop-down menu. Rather, you’ll 
get a Ribbon filled with commands and options. It also replaces the toolbars of previous Word versions. 
Each Ribbon is divided into different sections, where similar commands are grouped. You can access 
more options by clicking on the arrow in the lower-right corner of a section, beside the section title. On 
the Home Ribbon, the first section is the Clipboard. Here, you can cut, copy, and paste text and objects. 
You’ll also find the Format Painter.  
 
Home Ribbon Font Section in Word 2007 
The second section of Word 2007’s Home Ribbon is the Font section. You can change the typeface and 
font size. You can also apply font formatting options such as color, bold, italics, and underline.  
 
Home Ribbon Paragraph Section in Word 2007 
In the Paragraph section of Word 2007’s Home Ribbon, you’ll find options for working with entire 
paragraphs. You can add bullets and numbering. You can also apply an outline to your paragraph. You’ll 
also find alignment options, border and fill options, and line spacing.  
 
Home Ribbon Styles Section in Word 2007 
The Styles section on Word 2007’s Home Ribbon will help you apply Styles to sections of your 
document. This is helpful when you have intricately formatted portions of your document. It will save you 
a lot of work.  
 
Home Ribbon Edit Section in Word 2007 
The Editing section of Word 2007’s Home Ribbon is not what you’d expect. It contains tools to help you 
find specific parts of your document. You can also go to particular spots in your document or execute a 
find and replace.  
 
Changing the View and Zoom in Word 2007 
The taskbar has also been scaled back in Word 2007. You won’t see the statistics and command buttons 
familiar from earlier versions of Word. However, you can still access some commands. You can change 
document views or use the slider to adjust the document zoom.  

Selecting Similar Text Throughout a Document 
When you’re working on a document in Word 2007, you may decide to alter the formatting of certain 
parts of your document. Changing text formatting throughout your document is easy if you use styles. 
With styles, you can alter the style, automatically changing all text based on that style. Say, for example 
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that you want to change all text that is bold, 16-point Times New Roman. Simply position your cursor in 
a section of your document containing this formatting. In the Editing section of Word 2007’s Home 
ribbon, click Select and choose Select Text with Similar Formatting. Once you have selected the text 
bearing the formatting, you can change it using the options on the Home ribbon. It will make quick work 
of formatting changes! 
 
Inserting a Text Box in Word 2007 
To insert a text box in your Word 2007 document, open the Insert Ribbon. In the Text section, click the 
Text Box button. You will see a gallery of pre-formatted text boxes. These are an easy way to add well-
designed text boxes to your document. Scroll through the list and click one to insert it in your document. 
You can also draw your own text box. To draw your own text box, click Draw text box. Position the 
cursor where you would like to place the corner of your text box. Click and drag to draw your text box. 
Your text box appears with a border that you can use to resize or reposition the text box.  
 
Working With a Text Box in Word 2007 
Enter text in the box by clicking and typing in the box. Text in the box can be formatted like other text in 
your document. You can apply character and paragraph formatting. And you can use styles. You can’t use 
some formatting, such as columns, page breaks, and drop caps. Text boxes can’t contain Tables of 
contents, comments, or footnotes. When you're working in a text box, Word 2007 displays Text Box Tools 
on the ribbon. The Text Box Tools will display a Format ribbon. From the Format ribbon, you can apply a 
number of formatting options to your text box. For example, you can change the color and border. Or, add 
3-D and shadow effects to the box.  
 
Formatting a Text Box in Word 2007 
Word's Text Box Tools provide a number of options for formatting your text box. But, to apply advanced 
formatting, you will need to access the text box options a different way. To access advanced formatting 
options for your text box, right click the corner of the box. Select Format Text Box. The Format Text Box 
dialog box opens to the Colors and Lines tab. Here, you can change the background color and adjust the 
transparency. It also allows you to specify border style, color, and weight.  
 
Adjusting the Size of a Text Box in Word 2007 
When you draw a text box, you probably won't get the size exactly right. No worries. You can specify the 
dimensions of your text box in Microsoft Word 2007. Use the Size tab of the Format Text Box dialog box 
to specify the text box's dimensions in inches. You can also scale the text box size by entering a 
percentage.  
 
Setting the Margins for a Text Box in Word 2007 
On the Text Box tab of the Format Text Box dialog box, you can specify internal margins and vertical 
alignment for your text box in Word 2007. It also allows you to turn word wrapping on or off. And you 
can specify that the box automatically resize to fit the text.  
 
Changing Text Wrapping Options for a Text Box 
You may want to change the layout of your text box. You'll find the options for this on the Layout tab of 
the Format Text Box dialog box. Word 2007 provides you with a variety of options for changing the 
layout of your text box. For example, you can have the text wrap around the text box, or you can insert the 
text box inline with the document text. Select how you would like your text box to appear. For advanced 
options, such as the amount of space around the picture, click Advanced. Once you’ve specified your 
options, click OK.  
 
Create Photo Albums in PowerPoint 2007  
PowerPoint has an in built feature which lets you create albums within seconds. 
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1. Click on Insert tab. 
2. Click on the Photo Album Icon. 
3. Click File/Disk to select images from your hard drive. 
4. Arrange the sequence by using up and down keys. 
5. Click on Create and your album is ready. You can add notes and effects if needed. 
 
Quickly Apply Transition Effects 
In previous versions of Microsoft Office it was not easy to apply transition effects. In Power Point 2007, 
just click the Animation Tab on the Menu Ribbon. This opens a list of transition choices which you can 
apply in just one click. Put your pointer over the transition to view the intended result. Click on it to apply 
it to the slide. 
 
Using Smart Art in Office 2007 
A SmartArt graphic is a visual representation of your information and ideas. To insert a SmartArt graphic, 
click on the Insert tab in Word, PowerPoint, or Excel and click the SmartArt icon. From there, you are 
given different choices. Click on a choice to see an explanation of what the graphic does. Click OK to 
choose the graphic, then fill in the text and/or pictures. 
 
Arranging Document Windows 
If you have more than one document open at a time, Word allows you to view all the documents at the 
same time. 
1. Click the View tab on the Ribbon.  
2. Click the Arrange All tool in the Window group. This divides the screen space evenly between all your 
windows.  
3. Click on the window you wish to adjust. It becomes active.  
4. Move the mouse cursor near the border of the active window and drag the window edge to the desired 
size. Do this for each window you want to adjust.  
 
Change the Document Window Background Color 
You can change the background color to whatever you would like, but keep in mind that the color you 
choose is a part of the document and is visible when sharing the file. It does not show up when printed, 
however. 

1. Click the Page Layout tab on the Ribbon.  
2. Click the Page Color tool in the Page Background group.  
3. Choose the color you would like to use for your background.  
 
Putting your pointer over the color will give you a preview. Click to choose. 
 
Spell Check Shortcut Key 
If you want to spell-check a word, just use the keyboard to select it and then press F7. (If you press F7 
without selecting the word first, you'll spell-check the entire document.)  
 
Thesaurus Shortcut Key 
If you want to display the thesaurus, make sure the insertion point is within the word and then press 
Shift+F7.  

Right-Click Shortcut 
You can simulate a right-click on a word. Make sure the insertion point is within the word, then press 
Shift+F10. This shortcut has the same effect as right-clicking, and you can then choose whatever you want 
from the resulting Context menu. 
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Shortcut For Entering the Degree Symbol 
If you want to type the temperature with the degree symbol at the end, press Ctrl+Shift+@, let go and 
press the spacebar. The degree symbol will appear in your document. 
 
Typing Different Dashes 
There are three sizes of dashes. The smallest is the one you type using the minus key on the keyboard. The 
next sized dash (en dash) may be made by pressing Ctrl+-(minus sign) using the numeric keypad. The 
largest dash (em dash) is made by pressing Ctrl+Alt+-(minus sign) using the numeric keypad. 
 
Creating Filler Text 
If you need to do some testing, fill some space, or to see how text looks in a given page format, there is a 
way to add meaningless text to your document. Position the cursor at the beginning of a paragraph.  
Type =rand() and press Enter. Word replaces this text with 3 paragraphs of 3 sentences each. You can 
vary the number of sentences per paragraph, as well as the number of paragraphs, by using the format 
=rand(p,s). In this format, p is replaced with the number of paragraphs you want and s is replaced with the 
number of sentences per paragraph. So, if you wanted 9 paragraphs of 7 sentences each, you could use 
=rand(9,7). 
 
Drag and Drop Text Editing 
Select the text you want to move. Click on the text with the mouse and drag it to where you want it 
moved.  
Release the mouse button. If you want to copy your text (instead of actually moving it) you can hold down 
the Ctrl key while using the mouse to drag the selection. 
 
Removing the Paste Options Icon 
Word includes a feature that annoys some people: Paste Options. When you paste something into your 
document, Word displays a small, floating button near the end of the pasted information. If you move your 
mouse pointer over the button, you find that it is a drop-down menu giving you a few options that you can 
apply to what you just pasted. If you find the Paste Options button distracting, or if you never use it, you 
may want to turn it off. Follow these steps: 
 
1. Click the Office button and then click Word Options. Word displays the Word Options dialog box.  
2. Click Advanced at the left side of the dialog box.  
3. Scroll through the available options until you get to the Cut, Copy, and Paste section.  
4. Clear the Show Paste Options Buttons check box.  
5. Click OK.  
 
Repeating Your Typing 
If you type a word, phrase, or other passage of text, you can use the F4 shortcut key to repeat the typing at 
another location in your document. This shortcut key must be used before you use any other Word 
command or type any other text.  
 
Selecting a Sentence 
To select a sentence using the mouse, hold down the Ctrl key as you click anywhere within the sentence. 
The entire sentence, along with any trailing spaces, is selected. Note that Word does get a little confused if 
the sentence contains a period for an abbreviation (such as in Mr. or Mrs. or Dr.). If you have such a 
sentence, continue to hold down the Ctrl key as you move the mouse past the abbreviation. The rest of the 
sentence is then selected. 

Converting Tables to Charts 
Once you have created your table, you can convert the information directly into a graph.  
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1. Select the table you want converted to a chart.  
2. Make sure the Insert tab of the ribbon is displayed.  
3. Click the Object tool within the Text group.  
4. From the list of Object Types, choose Microsoft Graph Chart.  
5. Click on OK.  
6. Format your graph as desired.  
7. Click anywhere outside of the newly inserted graph to continue working in your document. 
 
Moving Objects Without Snapping to the Grid 
Left-click on an object, hold down the Alt key, and then use the mouse to drag the object to a new 
position. This disables the "snap to" grid. 
 
Show Shortcut Keys in Word 2007 
To display shortcut keys: 
1. Click the Office button and select Word Options. 
2. Open the Advanced tab. 
3. In the Display section, select Show shortcut keys in ScreenTips. 
4. Click OK 
 
When you hold the mouse pointer over a command button on one of the ribbons, a box will appear naming 
the command and showing the shortcut key for the command. This change will affect all of the Office 
2007 programs. 
 
Print Word 2007's Shortcut Keys 
1. Click Ctrl+P to open the Print dialog box. 
2. Find the drop-down box labeled Print what. 
3. Select Key Assignments. 
4. Click OK to print your list of shortcut keys. 
Most Used Shortcut Keys in Word 
New: Ctrl + N Creates a new blank document 
Open: Ctrl + O Opens a saved document 
Save: Ctrl + S Saves the current document 
Print: Ctrl + P Prints the current page 
Undo: Ctrl + Z Cancels the last change to the document 
Repeat: Ctrl + Y Repeats the last command 
Copy: Ctrl + C Copies the selected text to the clipboard 
Paste: Ctrl + V Pastes the cut or copied selection 
Cut: Ctrl + X Removes the selection and places it on the clipboard 
Find: Ctrl + F Finds text within the current document 
 
Some Function Keys Used as Shortcuts 
Help: F1 Opens Word’s Help center 
Save As: F12 Saves the current document with a different name 
 
Using the Slide Show View Button 
To view your show In PowerPoint 2007, go to View on the menu bar, and click on Slide Show in the 
Presentation Views box. There are several other actions associated with the Slide Show button. To see a 
miniature preview of your slide show without leaving the PowerPoint workspace, hold down the Ctrl key 
and click the Slide Show View button. If you want to quickly launch the Set Up Show dialog box so that 
you can adjust settings, hold down the Shift key as you click the Slide Show View button. The Esc key 
takes you back to normal view. 
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Correcting Mistakes 
The best thing to do if you make a mistake is to press Ctrl+Z. In most programs, that will undo whatever it 
was that you just did. The bad thing is that many programs only give you one or two of these "undo's." 
One way to make sure you can always go back is to save your file frequently - especially if you're about to 
make some big changes. Then if you really mess up, just close the file and DON'T SAVE IT. When you 
open it back up, it will be back to the way it was when you last saved.  
 
Select a Column or Row in Excel 
This one allows you to select an entire row or column with just two keys - and no mouse. Ctrl + Spacebar 
will select the column of the cell currently selected. Shift + Spacebar will select the row of the cell 
currently selected. You can then combine this information with the Shift + Arrow keys to select several 
rows or columns. 
 
Align Text with the Keyboard 
The following combinations will change the alignment of the paragraph where the cursor is currently 
located. There's no need to highlight the paragraph - it will be applied to the entire paragraph regardless. 
This can be done as you are typing the paragraph or later by using the arrows to scroll through the 
document from paragraph to paragraph. 
 
Ctrl + L will Left Align the text.  
Ctrl + E will Center the text.  
Ctrl + R will Right Align the text  
Ctrl + J will Justify the text. 

Setting a Digital Photograph as a Slide Background in PowerPoint 2007 
To insert a photograph as your slide background, choose Design on the menu bar, then click the down 
arrow next to Background Styles in the Background box. Next, click on Format Background at the bottom. 
On the Fill panel, click the button in front of Picture or Texture Fill. Under Insert From, click on File and 
choose your photo. Your photo will be applied to your slide. Click Apply To All to fix the image to the 
background of all your slides, or click Close to set it to just the current slide's background. 
 
Inserting Foreign Characters in Word 
One way to enter foreign characters is to choose Symbol from the Insert menu, and then look for the 
character you need. You can also use shortcuts for creating foreign characters. Some of these shortcuts are 
as follows: 
Ctrl+' Adds an accent to the character typed next 
Ctrl+~ Adds a tilde to the character typed next 
Alt+Ctrl+? Creates an upside-down question mark 
Alt+Ctrl+! Creates an upside-down exclamation mark 
 
Maximize and Minimize Windows Quickly 
To maximize or minimize the size of any window, double-click the title bar. 
 
Right-click Using Your Keyboard 
Three keys to the right of your space bar is a key that looks like a menu with an arrow pointing to it. Space 
Bar, Alt Key, Windows Key and then the Menu Key. If you press the Menu Key, it will bring up the menu 
you normally bring up when you right-click. From there you can use the arrow keys to navigate through 
the pop-up menu and the Enter key to select your choice. To get out of the pop-up menu, press the Esc 
key. 
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Quickly Add Multiple Rows in Excel 2007 
To add several rows in Excel, select the number of rows you want to insert, Then click on Insert in the 
Cells section of the Home Ribbon. If you want to add more, you can press F4 repeatedly until you have 
created the number of desired rows. 
 
Temporarily Stop Word Wrap 
If you have a phrase, date, title or some other group of word that you don't want Word to split apart when 
it wraps around to the next line, as you're typing the words use Ctrl+Shift+Space Bar when you space 
between the words. The words on either side of a space put in this way will stay together. If they don't all 
fit on the first line, then all words will be put on the next line. 
 
Inserting a Section Break in Word 2007 
Click where you want to insert a section break. On the Page Layout Ribbon, in the Page Setup section, 
click the Breaks button. Under Section Breaks, click the option that describes where you want the new 
section to begin.  
 
*Next page inserts a section break and starts the new section on the next page.  
*Continuous inserts a section break and starts the new section on the same page.  
*Even page or Odd page inserts a section break and starts the new section on the next even-numbered or 
odd-numbered page. 
 
Moving Breaks Quickly in Word 2007 
In the previous Word tip you learned how to insert breaks into your text. If, after inserting them, you 
discover that you need to move the break to a new location, you can follow these steps: 
 
1. On the View Ribbon, in the Document Views section, choose Draft.  
2. Select the break by clicking on the break line. 
3. Press Ctrl+X. The break is cut from your document. 
4. Position the insertion point where you want to insert the break. 
5. Press Ctrl+V. The break is inserted into the new location in your document. 
 
Decorative Lines 
A horizontal line is one way to separate a section of your document from another. To create such a line, 
you can use the method of typing three asterisks, three dashes, three tildes, or three underscores in a row 
and pressing Enter. Word will replace each of these character sequences with a margin-to-margin line. For 
other options, click on the Page Layout Ribbon. In the Page Background secction, choose Page Borders. 
At the bottom of the Borders and Shading window, click on the Horizontal Line button. Choose the line 
you wish to use, and click OK. 

Resizing Excel Columns in 2007 
Instead of manually resizing a large number of Excel columns, you can click in a column header and then 
press and hold Ctrl while you click other column headers. After you've selected all the columns you want 
to size, in the Cells section, choose Format, Column Width and set your new width. You could also 
choose Format, AutoFit Column Width to make sure everything fits in the selected columns. 
 
Changing Case in Word 2007 
Change Case is an option that allows you to correct a case mistake without retyping. (Case referring to 
capital or small letters.) Once you decide you need to make a correction you should select all of the text 
that needs to be changed. Then go to the Font section, click on the Change Case button (Aa). The Change 
Case window will open with a list of choices. Pay attention to the formatting of the words in the list, as 
they are actual examples of how the text will look once you make that choice. (Toggle case is to switch 
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the case of every letter highlighted.) Choose an option and then click OK. The keyboard shortcut for this 
is Shift + F3. Clicking F3 repeatedly will cycle through the choices. 
 
Fast Spelling Corrections 
As you are typing in your document, you may have noticed that some of your words are underlined with a 
red wavy line. These are words for which Word is questioning your spelling. You can quickly correct your 
spelling (assuming you agree that it may be incorrect) by right-clicking on the word in question. The 
resulting Context menu contains spelling suggestions that you can select. Word then replaces the word on 
which you right-clicked (the incorrect word) with the proper spelling. 
 
Creating a Text Box for Existing Text in Word 2007 
If you have some text you would like to put in a text box, select the text and click on the Text Box button 
on the Draw toolbar. This will automatically place a text box around the existing text. You can then size, 
move, and format the box. In Word 2007, select the text, click on the Insert ribbon, in the Text section, 
click on Text Box and choose Draw Text Box at the bottom of the dialog box. 

Align Objects on a PowerPoint 2007 Slide 
There is a way to automatically place or align objects evenly with other objects in a slide. Hold down the 
Ctrl key while you select the objects by clicking on them. Then on the Home Ribbon, click on Arrange in 
the Drawing section. Under Postition Objects, click Align, select one of the options, and the objects will 
be aligned automatically. 

Office Ribbon Buttons 
If you aren't sure what a button does on an Office 2007 Ribbon, hold your mouse pointer over the button. 
A box will pop up with information about that feature. Pressing F1 will bring up Online Office Help. 

Recording a Narration in PowerPoint 2007 
You can easily record a narration into a PowerPoint slide if you have a microphone. Go to the slide you 
wish to add a narration to. Click on the Insert Ribbon. In the Media Clips section, click the down arrow on 
the Sound button. Choose Record Sound. When ready, click the Record button (the red circle). When 
finished recording, click the black Stop button. Give your recording a name in the Name box. Click OK. 
For more options, click on the sound icon, and then click on the Sound Tools Options ribbon. 

Word 2007 Document Zoom 
In Word 2007, the Zoom feature is no longer at the top of the page. If you want to zoom in or out in 
viewing your document, use the slider bar in the bottom right section of the status line. 

Applying a Border to Part of Your Document 
To apply a border to a portion of your document, first select that part of your document. Click on the Page 
Layout Ribbon. Double-click the Page Borders button in the Page Background section. On the Borders 
tab, select a line style in the Style section. Next, use the Color drop-down box to specify the border line 
color. Click More Colors at the bottom of the list for a greater range of options. Then select a line weight 
in the Width drop-down box. Add or remove edges in the Preview section. Click OK to see your border. 

Quickly Resize Columns in Excel 
When using Excel, save time by first typing in all the data. Then, double-click the lines in the column 
headers between each column to automatically resize the columns to fit the data.  

Select Hidden Objects on PowerPoint Slides 
If you are trying to edit an object on your slide that is covered by another object, click the mouse outside 
of the slide area, or press the Esc key on the keyboard, so that nothing on the slide is currently selected. 



 10
Use the Tab key on the keyboard to cycle through the objects on the slide until the one you want to edit 
is selected. 

Numbering Pages in Word 2007 
Word lets you put page numbers at the top or bottom of the page, and you can format them however you 
like. When you add or remove pages, Word renumbers the pages in your document automatically. Click 
on the Insert Ribbon. Click on Page Number in the Header & Footer section. Put your pointer over the 
option you wish to use, and then choose a style by scrolling through and choosing from the list. Select any 
other options you want from the Header & Footer Tools Design Ribbon, then Close with the red x or 
double-click your document.  

Restore a Picture to the Original in 2007 
If you insert a picture into a program and make changes to it, there is an easy way to return the picture to 
it's original state. Click on the picture. Click on the Picture Tools Ribbon. In the Adjust section, click 
Reset Picture. This will return the picture to it's original size. This works in all Office programs. 

Save a PowerPoint 2007 Slide as a Picture File 
Once you have created your PowerPoint presentation, you can make picture files of all or certain slides in 
the presentation. Click on the slide that you wish to save as a picture. Click on the Office Button. Put your 
mouse pointer over Save As and choose Other Formats. Give the file a name. In the Save as type: drop 
down list, scroll down and choose the JPEG File Interchange Format. Click the Save button. Choose if 
you want to save Every Slide or the Current Slide Only. You can then open the file and edit it as you 
would any graphic. 


